DESIGNING NON-LINEAR STORYTELLING ENVIRONMENTS FOR NON-DEVELOPERS: THE CASE OF THE SKG PARKS PAGE

Aneza Mouladoudi

Supervisors:

Charalampos Dimoulas
Andreas Veglis
Panagiotis Tsarchopoulos

Thessaloniki, May 2017
Abstract

Storytelling is a powerful way to transfer meanings, and websites constitute a multidimensional and interactive storytelling environment. With the rise of the Web into an essential part of our everyday lives, the existence of a web presence has become vital. It is therefore important for users who lack coding skills to be able to deliver successful websites. Web building platforms that have emerged in the past few years offer this possibility. This dissertation illustrates a method that non-developers can adopt in order to create a quality non-linear storytelling environment delivered through the Web by using these platforms, in combination with the foundations that web development and web design theories provide.
# NON-LINEAR STORYTELLING ENVIRONMENTS

## Contents

Abstract .......................................................................................................................... 2

Introduction .................................................................................................................. 6

1. Theoretical and Methodological Background .......................................................... 7
   1.1 Introduction to the concept of Storytelling and Multimedia Storytelling environments 7
      1.1.1 The concept of storytelling ........................................................................ 7
      1.1.2 From traditional storytelling to multimedia storytelling ........................... 7
      1.1.3 Linear and non-linear storytelling ............................................................... 7
      1.1.4 The role of User Generated Content ......................................................... 9
      1.1.5 User Generated Content and moderation issues ...................................... 10
   1.2 Software and Web Development Models ............................................................. 11
      1.2.1 The Waterfall model ................................................................................ 12
      1.2.2 The Agile model ....................................................................................... 12
      1.2.3 Component Based Software Engineering ............................................... 13
      1.2.4 Non-developers approaches and practices ............................................... 14
      1.2.4 Planning ................................................................................................... 14
   1.3 Main Idea & Topic background .......................................................................... 16
   1.4 Chapter summary .............................................................................................. 18

2. Project Analysis ....................................................................................................... 19
   2.1 Overview of the current landscape .................................................................. 19
      2.1.1 Related applications: Greek Websites .................................................... 19
      2.1.2 Related applications: International Websites ......................................... 21
   2.2 Purpose ............................................................................................................. 24
   2.3 Motivation ......................................................................................................... 24
   2.4 Target audience ............................................................................................... 25
      2.4.1 Working with Google Forms ................................................................. 25
      2.4.2 User analysis results .............................................................................. 29
   2.5 Chapter summary ............................................................................................. 34

3. Project and Application Design .............................................................................. 35
   3.1 Introduction ....................................................................................................... 35
      3.1.1 The importance of Web presence ............................................................ 35
      3.1.2 Traditional website development vs. website building platforms ............ 35
      3.1.2.1 Content Management Systems .......................................................... 35
      3.1.2.2 Online Website building platforms ................................................... 36
NON-LINEAR STORYTELLING ENVIRONMENTS

3.2 Design Basics ................................................................. 38
  3.2.1 Visual Hierarchy & Page layout patterns.......................... 38
    3.2.1.1 The Gutenberg diagram...................................... 39
    3.2.1.2 The F-pattern.................................................... 39
    3.2.1.3 The Z-pattern.................................................... 39
    3.2.1.4 Colors ............................................................. 40
3.3 Working with Wix .............................................................. 40
  3.3.1 The Platform ............................................................ 40
  3.3.2 Getting started ......................................................... 41
  3.3.3 The Left Menu ........................................................ 43
  3.3.4 The Pages Menu ....................................................... 44
  3.3.5 The Editor Toolbar .................................................. 45
  3.3.6 The Right-click Menu .............................................. 46
  3.3.7 Gridlines ............................................................... 47
  3.3.8 Site Manager .......................................................... 47
3.4 Thematic Categories and Pages ......................................... 48
  3.4.1 Homepage ............................................................. 48
  3.4.2 The Parks ............................................................. 49
  3.4.3 Individual Park Page ............................................... 49
  3.4.4 Video Tour .......................................................... 49
  3.4.5 Location and Transportation .................................... 49
  3.4.6 Blog ................................................................. 49
  3.4.7 Contact ............................................................. 49
  3.4.8 Navigation Plan ..................................................... 49
3.5 Chapter summary ........................................................... 50
4. Project Development .......................................................... 51
  4.1 Working with prototypes ............................................... 51
    4.1.1 First Prototype .................................................... 51
    4.1.2 Second Prototype ................................................ 53
  4.2 Gathering the Material ................................................ 55
    4.2.1 Texts ............................................................... 55
    4.2.2 Images ............................................................. 56
    4.2.3 Video ............................................................... 56
    4.2.4 Logo ............................................................... 56
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.2.5 Customized Location Map</td>
<td>57</td>
</tr>
<tr>
<td>4.3 Development with Wix</td>
<td>58</td>
</tr>
<tr>
<td>4.3.1. Getting started</td>
<td>58</td>
</tr>
<tr>
<td>4.3.2. Header</td>
<td>59</td>
</tr>
<tr>
<td>4.3.3 Logo</td>
<td>60</td>
</tr>
<tr>
<td>4.3.4 Homepage</td>
<td>61</td>
</tr>
<tr>
<td>4.3.5 Footer</td>
<td>63</td>
</tr>
<tr>
<td>4.3.6 The Parks</td>
<td>64</td>
</tr>
<tr>
<td>4.3.7 Individual Park pages</td>
<td>64</td>
</tr>
<tr>
<td>4.3.8 Video Tour</td>
<td>65</td>
</tr>
<tr>
<td>4.3.9 Blog</td>
<td>66</td>
</tr>
<tr>
<td>4.3.10 Location &amp; Transportation</td>
<td>67</td>
</tr>
<tr>
<td>4.3.11 Contact</td>
<td>67</td>
</tr>
<tr>
<td>4.4. Mobile Version</td>
<td>68</td>
</tr>
<tr>
<td>4.4.1 Motivation</td>
<td>68</td>
</tr>
<tr>
<td>4.4.2 Working with the Invision platform</td>
<td>68</td>
</tr>
<tr>
<td>4.4.3 The mobile application version Interactive Prototype</td>
<td>74</td>
</tr>
<tr>
<td>4.5 Chapter summary</td>
<td>79</td>
</tr>
<tr>
<td>5. Project and Services Evaluation</td>
<td>80</td>
</tr>
<tr>
<td>5.1 Qualitative Evaluation</td>
<td>80</td>
</tr>
<tr>
<td>5.2 Quantitative Evaluation</td>
<td>83</td>
</tr>
<tr>
<td>5.2.1. Metrics</td>
<td>83</td>
</tr>
<tr>
<td>5.2.3 Results</td>
<td>85</td>
</tr>
<tr>
<td>5.3 Mobile app assessment: evaluating interactive prototypes</td>
<td>97</td>
</tr>
<tr>
<td>6. Project Summary</td>
<td>100</td>
</tr>
<tr>
<td>6.1 Summary &amp; Conclusions</td>
<td>100</td>
</tr>
<tr>
<td>6.2 Thesis novelty and contribution</td>
<td>101</td>
</tr>
<tr>
<td>6.3 Further Work</td>
<td>101</td>
</tr>
<tr>
<td>6. References</td>
<td>102</td>
</tr>
</tbody>
</table>
Introduction

Storytelling has been used throughout the years in order to transfer meaning. Since the days that stories existed only in the form of oral communication, they have come a long way. The use of multimedia and the advancements of the Web created multidimensional and interactive environments which provide a rich experience.

Websites constitute such enriched storytelling environments. Nowadays the existence of a Web presence is considered the norm, whether being an individual, an organization, or a small business. It is therefore of great importance to achieve the democratization of the web development process. The web development platforms that have emerged in the past few years constitute an important step towards this direction.

The purpose of this dissertation is to illustrate the method that a non-developer can adopt in order to create a successful website that will be able to deliver stories through a rich media experience.

The first chapter covers the theory behind storytelling and its transition to its current form through technology advancements. Furthermore, it includes the Software and Web Development models that are used when developing a web application. Finally it presents a detailed description of the topic that the project deals with.

The second chapter studies the current landscape as far as the topic is concerned, followed by the purpose and Target audience of the project.

The third chapter presents the theory that was studied concerning the design of the website. It also includes a presentation of the platform that was used in order to develop the website. Finally, it illustrates the planning and thematic categories of the project website.

The fourth chapter deals with the actual implementation of the project website, from the prototyping process to the step by step development with the platform. Moreover, the development of an interactive prototype for a mobile version is described.

The fifth chapter includes an evaluation of the produced website and the sixth chapter proposes the further work that can be done.

The sixth and final chapter includes a summary and the conclusion of the project undertaken.
1. Theoretical and Methodological Background

1.1 Introduction to the concept of Storytelling and Multimedia Storytelling environments

1.1.1 The concept of storytelling

Stories have always had great power and have been an important part of life. Storytelling is a process that exists from the start of our lives, when children start a learning process of literacy and communication, through "bedtime" stories in an engaging and entertaining way (Huffaker, 2004). Sharing information throughout history became possible through storytelling, which involves "the act of using language and gesture in colorful ways to create scenes in a sequence" (Gere, Kozlovich & Kelin, 2002).

The form of storytelling can vary, but the main idea is the transferring of meaning. According to Mcluhan (1989), sound provided the first medium that mankind used in order to communicate their perception of the world. Moreover, he describes the existence of two separate spaces of communication, acoustic and visual. While visual communication offers more elements and provides a richer medium, it still incorporates the content of orality, such as literature, spoken narratives, and drama.

1.1.2 From traditional storytelling to multimedia storytelling

Advancements in technology, and in particular the evolution of the Internet and digital media has prompted new approaches on storytelling. These include most of the elements of traditional storytelling but incorporate the use of computer-mediated communication, in addition to adding unique features and characteristics to it. The digital transformation of Storytelling is made through the use of multimedia, resulting to what is known as “Multimedia Storytelling”. A multimedia story combines text, photographs, audio and video in a way which all of these media complete each other in order to form a story. As Collins, Hammond and Wellington (1997) argue, in the process of understanding and learning, the concept of interaction between images, sounds and written words is one of great importance, so multimedia storytelling revolutionized the way stories are delivered and perceived by the audience. These stories can now be delivered through the Internet via a web browser, resulting in a rich media experience. Multimedia storytelling provides the audience with an interactive narrative experience. This experience is multidimensional and is characterized by interactivity, user engagement and participation which can lead to collaboration of the creators and the audience, for a co-creation of stories (Barber & Siemens, 2016).

1.1.3 Linear and non-linear storytelling

A linear story has a flow with clearly defined beginning and end. A non-linear story on the other hand can deliver more complex experiences. The various parts of a non-
linear story complete each other using different media, each of which has its own part and goal in the formation of the final story (Cao & Jarke, 2012).

A non-linear, multimedia storytelling experience has a number of unique features that were not possible to achieve with traditional storytelling techniques. One of the main characteristics of a non-linear storytelling environment is Interactivity. Interactivity is considered to be a vital concept in computer-mediated communications, due to the fact that it is the key advantage of the medium (Morris & Ogan, 1996; Pavlik, 1996; Rafaeli & Sudweeks, 1997). Researchers have suggested that individuals with computer activities desire to create interactive representations (Nielson, 1990). Interactivity leads to engagement in communication and relationship building between the website and its target audience. According to Ha & James (1998), interactivity should be capable of fulfilling the following five different communication needs: playfulness, choice, connectedness, information collection, and reciprocal communication. Figure 1.1 illustrates linear and non-linear storytelling.

![Figure 1.1. Linear and non-linear storytelling (Dimoulas, 2015, p.26).](image)

Interactivity became a vital part of websites mainly with the advent of Web 2.0, the second generation of the web (and also called the read/write web). In this new era users transform from passive readers to active contributors of content. This brings a new bi-directional relationship between them and the Web (Aghaei & Nematbakhsh, 2012). A current form of interactivity display, which has gained popularity with the rise of mobile devices, is the use of User Generated Content, which is explained in the next subchapter.
O’reilly (2009) defines Web 2.0 as “a set of social, economic and technology trends that collectively form the basis for the next generation of the Internet – a more mature, distinct medium characterized by user participation, openness and network effects”. He describes several principles that are preliminary for its core of existence (O’reilly, 2007), some of which are vital characteristics of multimedia storytelling environments. Those are "Harnessing collective intelligence”, which means that developers should user participation into account when designing their applications, so as to benefit from the intelligence that it provides. This way, participation adds more value to the existing database of information (Conn, 2007). Another one is "Data is the next Intel inside”. The Web has become full of data-driven applications, which acquire their value from the data itself and create more data as a result (Loukides, 2010). Another important principle is "Rich user experience", which points to a more dynamic user experience, enhanced with features of interactivity which are enabled by rich internet applications. Users can gain more control on the applications by interacting with its elements, for instance with the drag and drop method (Valtari, 2009).

1.1.4 The role of User Generated Content

Another major breakthrough that came along with web 2.0 and the interactivity features it introduced is the adoption of User-Generated content (UGC) by many websites as a source of a continuous flow of new content. In contrast to content of traditional producers, UGC is created and uploaded to the website by specially designed for this purpose tools, by ordinary users.

UGC is often used to refer to content uploaded by users through popular platforms such as Facebook, Twitter, BlogSpot, YouTube, Instagram and other social platforms. While there is no clear definition of the term, OECD cites it as content contributed by ordinary users that contains “certain amount of creative effort”, and that is “created outside of professional routines and practices” (Vickery & Wunsch-Vincent, 2007). Trosow et al. (2010) define it as “content that is voluntarily developed by an individual or a consortium and distributed through an online platform”. The advancements in digital technology produced media tools that were affordable and accessible for ordinary users, which led to a blooming of content production by individuals and a democratization of such production. Jensen (2007) and Trosow et al. (2010) suggest that UGC is divided in three categories: (1) Creative content authored and distributed by individuals or small informal groups, (2) Software modifications or applications written by individuals to operate within or augment specific previously existing datasets or hardware or software platforms (3) Content collaboratively produced and disseminated.

While in traditional media, the creators and the consumers of content constitute two separate actors, in User Generated Content, the users are both creators and consumers. Some starting forms of User Generated Content can be found in the Bulletin Boards that were popular from the days of Web 1.0. With the emergence of platforms such as Blogger, Wikipedia, YouTube and Social Networking Sites such as Facebook, Twitter and Instagram, it gained more and more popularity. This led to a rapid increase of
user engagement globally and also lowered the content distribution cost (Bonhomme, Christodoulides & Jevons, 2010).

There are a number of reasons that push users into contributing content to such platforms. Burmann & Arnhold (2008) suggest that it is the desire to collaborate information about other users, interaction and creativity, while Berthon, Pitt and Campbell (2008) cite that users are aiming for self-promotion, change of public perceptions and intrinsic enjoyment. But whatever the motive, User Generated Content has an impact, not only on market outcomes (such as the effect of reviews on purchases), but also in social behaviours, spanning from views on public health to voting intention (Luca, 2015).

With the adoption of mobile devices as an essential part of our everyday life, there has been an explosion of shared content produced by end users. Mobile users in particular, contribute content that has particular temporal and spatial properties, such as the time and place the content was created, that produce added value (Lenders, Koukoumidis, Zhang & Martonosi, 2008).

1.1.5 User Generated Content and moderation issues

Of course this enormous volume of content contributed by end-users contains a lot of inappropriate or unsuitable elements that need to be ruled out in order to have a functional online environment, even more so when creating a storytelling environment. In order to maintain a successful, clean image and guard against the “digital damage” (Roberts, 2016) that could be triggered by false, inappropriate or even illegal content, there has to be a moderation process. This process can either take place before the content is submitted to a platform, or after its submission. In particular, content moderation can take place as a result of complaints coming from website administrators, external actors such as companies that detect material misappropriation or from other end users that are offended by uploaded content and report their disagreement by platform-supported mechanisms such as flagging of offensive or inappropriate content (Roberts, 2014). So while User Generated Content provides an enormous pool of content, it needs to be handled with caution in order to be incorporated in harmony in a digital storytelling environment.
1.2 Software and Web Development Models

When developing a website, one must decide the right method for the design and developing process. The choice of the correct software development life cycle (SDLC) is a task of great importance, as it influences the outcome of the project. Software Development Life Cycle contains all the phases that are vital for the completion of a project, from planning and analysis to design and implementation. There are several established SDLC models for this purpose, such as Waterfall, V-model, Spiral and Agile (Balaji & Murugaiyan, 2012).

The term Software might not seem directly linked to the particular project, but it covers a much greater range than the average user perceives. From the perspective of a software engineer, the Web is a differentiated application platform. Therefore, it is difficult for classic process models to be applied for the development and further evolution of web applications (Gaedke & Gräf, 2001). Multimedia and web applications are essentially subcategories of software development technology (software engineering). In this sense, the term incorporates multiple application and tools, configuration files, documentation, user manuals etc. Moreover, in current practices, along with the basic software, a respective website is usually developed, which is enriched with multimedia elements in order to inform, support and interact with users (Chatzara, 2013).

SDLC process models include all the actions necessary to complete an application, starting from the initial planning to the design, development and maintenance of the finished product. All process models cover the distinct phases that software process defines, but in a different sequence or manner. This is what differentiates one model from another. This means that each model is an approach to the SDLC which describes the sequence of steps that need to be followed when developing a software project (Mandal & Pal, 2014).

Although there are generally many differences between the models in the developmental stages and their sequence, there are some fundamental processes involved in almost all of them. Balaji & Murugaiyan (2012), suggest that before deciding on a model to be used, the developer must answer the following questions:

I. How stable are the requirements?
II. Who are the end users for the system?
III. What is the size of the project?
IV. Where are the Project teams located?

Two of the most prominent models established for Software Development are Waterfall and Agile.
1.2.1 The Waterfall model

The Waterfall model was introduced in software engineering in 1970 by Winston Royce, in a paper where he described it as a flawed software development method, due to its shortcomings (McCormick, 2012). The waterfall model is considered before all other models, as it has had a big effect on software development and influenced many of the SDLC models that are prevalent today (Ruparelia, 2010).

The waterfall model can be described as a linear model. It is characterized by a sequential process where every requirement must be clear before proceeding to the next phase. The testing takes place once the product has been fully developed and each activity is performed in a specific time period without overlapping other processes. This means that once the project has reached a certain step, the developer cannot return to a previous step and the whole project must start from the beginning.

The positive qualities of this model are that it provides clear requirements, easy implementation because of its linearity, and requires minimal resources for its implementation (Balaji & Murugaiyan, 2012). On the negative side, the errors that are found cannot be changed without re-starting the project, there is a high amount of risk and the outcome can only be tested at the end.

The progress of the project flows downward, and this is the reason the term “waterfall” was adopted. The waterfall model contains the following phases (McCormick, 2012):

I. Requirements: This is the phase where the developer must understand the functions and purpose of their project. The requirements must be listed in detail in order to ensure a smooth working in the upcoming phases.

II. Analysis: The tools, such as software and hardware needed for the completion of the project must be analyzed in this stage.

III. Design: In this phase, the software code must be presented. This stage is very important, as proper design leads to a functioning execution.

IV. Coding: In this stage, the actual coding takes place and the project is materialized. The successful work of previous phases results in a smooth implementation of the coding.

V. Testing: After the coding is complete, the testing process detects any flaws in the software and checks if the result meets the specifications.

VI. Acceptance: This is the last phase, and if all previous stages have been implemented successfully, it ensures the satisfaction of the target client.

1.2.2 The Agile model

The Agile model, on the other hand, is more of a philosophy than a process. It is a mindset under which a project is undertaken. In 2001, a group of software developers created in Utah one of the most inspirational development documents, the Agile Manifesto. This document describes 12 principles to be followed when developing software, focusing on customer satisfaction, changing requirements in any stage of the
development, shorter timescales, collaborative work, sustainable development, enhancement of agility and simplicity (Fowler & Highsmith, 2001).

The element of the Agile model that made a difference is the moving away from the upfront specification of everything, in contrast with other models such as the Waterfall. Rather than that, Agile is about a continuous and flexible process that invites groups of people to come up with ideas throughout the project progression. This results to the ability to respond to continuously changing requirements and rapid delivery which ensures customer satisfaction. It is a flexible and realistic approach to development that promotes teamwork and is suitable for smaller projects. The disadvantage of this model is its difficulty to apply to larger scale projects, as it is difficult to assess the time and resources needed and it might lead to a constant circling back to apply changes. This means that it requires a high level of commitment from the developer’s side. The Agile Manifesto does not present us with actual concrete steps, so developers should seek for subsets of Agile that represent development methodologies based on the principles of Agile, such as Scrum, Extreme Programming, Feature-driven development and Adaptive System Development.

1.2.3 Component Based Software Engineering

An interesting approach that is extensively used in multimedia projects is Component Based Software Engineering (CBSE). This method provides the ability to use existing code products or elements. It is often used by large companies that tend to develop multiple similar products for different customers. It is also useful in cases of collaborators that lack the coding skills, experience and expertise, often in the multimedia field. Another area of application of the particular method is the maintenance or further extension of Multimedia products by the customers, after the fulfillment on the developer group’s part. Finally, it is particularly useful for freelancers that can take advantage of the use of existing material.

As its name suggests, CBSE is facilitated by the availability of existing code that enables its modification and direct reuse. This leads to the delivery of fast and effective software solutions. CBSE starts with a requirements analysis followed by the analysis of the existing code to be used. The next stage is the modification of requirements, after which comes the design process with the re-use of the existing code. Finally, the development and finalization of the product takes place, followed by the validation (Figure 1.2). When adopting the CBSE method it is important to ensure that the rights for using and modifying the already existing software are properly used (Dimoulas, 2015).
1.2.3 Non-developers approaches and practices

O’reilly and Musser (2006), suggest that when developing a website, the best practices to consider using are agile and iterative approaches, as these techniques support readiness for change. As mentioned before, SKG parks is an attempt to show how non-developers can create a website, so there needs to be a more simplistic approach to the aforementioned models, while keeping the basic principles of them in mind.

SKG parks is a small scale project whose basic requirements are clearly defined. The nature of the building platform that is used for its development though, can be described as unpredictable, as they are web based and third party-owned. Secondly, it is intended to gather feedback through prototyping so as to change or enhance the design of the website. Thirdly, the addition of more functions is to be decided once the first finalization of the website is done with the platform, so as to assess the opportunities and limitations it offers. For the above reasons, the project needs to follow the principles of the Agile philosophy, incorporating to it the prototyping process. Additionally, since we are using a pre-existing platform to build the website, elements of the CBSE method are used.

1.2.4 Planning

The general planning used for the development stages after taking into consideration the aforementioned guidelines is presented in Table 1:
Table 1: Suggested (generic) planning in related web-/multimedia authoring project

<table>
<thead>
<tr>
<th>Stage 1</th>
<th>Stage 2</th>
<th>Stage 3</th>
<th>Stage 4</th>
<th>Stage 5</th>
<th>Stage 6</th>
<th>Stage 7</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial meeting of the production team to discuss project and specification setting</td>
<td>Design: From the main idea to the implementation of first (low-fidelity) prototypes</td>
<td>Evaluation of prototypes and deliberation on changes needed</td>
<td>Content production: Gathering of photos, video, audio and text</td>
<td>Development on the platform: Content organization and authoring</td>
<td>Evaluation of the first version of the application and deliberation on changes and addition of features</td>
<td>Implementation of changes / updates and validation of the final application</td>
</tr>
</tbody>
</table>
1.3 Main Idea & Topic background

This paper deals with the project named SKG Parks. SKG parks is a website which aims to provide detailed information about the 13 thematic parks that are situated across the waterfront of the city of Thessaloniki, which is called “Nea Paralia” (New Waterfront).

The city of Thessaloniki financed the project of the reconstruction of its Waterfront, with further financial aid from the European NSRF programs. This project was undertaken by a duo of Architects, Prodromos Nikiforidis and Bernard Cuomo. The Call for tenders took place in 2000-2001 and the project was assigned to Nikiforidis and Cuomo in 2002. Its planning was completed in 2006, and in 2007 the implementation of the first part began. The first phase of the implementation included the area spanning from Thessaloniki’s Concert Hall up until the Sailing Club’s facilities and was completed in 2008. It covered the distance of approximately 1.5 km, and more specifically a surface of 95000 m2. The second phase, concerning the area spanning between the Vassiliko Theatre and the Sailing Club’s facilities area, started its construction works in 2011 and had been finished by 2013. It covers a total surface of 80.000 m2, including 49.700 m2 of pedestrian surfaces, 30.000 m2 of green parks and 190 m2 of water. Moreover, it includes cleaning sites, bars, playgrounds, outdoor amphitheaters, aesthetic and functional upgrades of the space, creating a promenade of 1,103 meters and a cycle track.

Before the project was implemented, the area was generally neglected, without any areas of green or facilities of any kind. That had caused people to gradually desert the area, as it was considered to be degraded. According to the architects, who consider this project the biggest of their career so far, the general concept of the project was the reconstruction of the area while keeping in mind the special characteristics of the waterfront’s landscape. The first major characteristic is its linearity, covering a length of 3,500 meters with a width that ranges from 50 to 150 meters. The second characteristic is its proximity with the sea, which had to be thought as the “background” of the project. The aim was to create a big promenade in line with the seafront, giving people the chance to enjoy the scenery while at the same time creating areas of green. Based on this logic, the aforementioned thematic parks were created, each of which captured a separate identity. The creation of the thematic parks was a combination of specific characteristics that pre-existed in the area with elements that the architects picked up from various areas of Macedonia that they visited in order to get inspiration. As a result, each park has a theme that emerges from a specific element on which the Architects invested on. (Nikiforidis, P. & Cuomo, B., Personal communication, June 15, 2016).
As mentioned before, SKG parks focuses on the thematic parks that resulted from the project of the reconstruction of the waterfront. More specifically, the parks that were created are 13, each one with its own identity and special characteristics: The Garden of Alexander, the Garden of the Afternoon Sun, the Garden of Sand, the Garden of Shadow, the Garden of Seasons, the Garden of Odysseas Fokas, the Garden of the Mediterranean, the Garden of Sculptures, the Garden of Sound, the Garden of Roses, the Garden of Remembrance, the Garden of Water and the Garden of Music.

Since its completion, the project gave a new life to the previously neglected area of Thessaloniki's waterfront. Citizens have embraced it, making it one of the city's busiest meeting points. The reconstruction of the waterfront has upgraded the city's image, giving it a beautiful public space. The project has been internationally acknowledged, receiving numerous awards, leading to a positive promotion of the city as a touristic destination.

In 2009, Nikiforidis and Cuomo were awarded the Grand Architecture Award from the Greek Institute of Architecture for the years 2004-2008. In 2015 the project was shortlisted for the Mies Van der Rohe award. The duo has also won the audience award for the project in the international ArchMarathon award. Table 2 shows the awards that the project of the reconstruction of the waterfront of Thessaloniki has won (Gerakaritou, 2016).

<table>
<thead>
<tr>
<th>Year</th>
<th>Award Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2009</td>
<td>“Oikopolis” Award for the first phase of the project (Awarded to the Municipality of Thessaloniki).</td>
</tr>
<tr>
<td>2009</td>
<td>Greek Institute of Architecture – Grand Architecture Award for 2004-2008</td>
</tr>
<tr>
<td>2011</td>
<td>Honor from Greek Architects’ Union (SADAS-PEA)</td>
</tr>
<tr>
<td>2013</td>
<td>“Oikopolis” Award for the second phase of the project (Awarded to the Municipality of Thessaloniki).</td>
</tr>
<tr>
<td>2014</td>
<td>First prize (Friendly Spaces accessible to all) at International Union</td>
</tr>
<tr>
<td>2014</td>
<td>First Prize at Domes Awards</td>
</tr>
<tr>
<td>2014</td>
<td>First Prize at Greek Architects’ Union (SADAS-PEA) awards</td>
</tr>
<tr>
<td>2015</td>
<td>First prize at ArchMarathon 2015</td>
</tr>
<tr>
<td>2015</td>
<td>Shortlisted at Mies Van der Rohe Awards</td>
</tr>
<tr>
<td>2016</td>
<td>First Prize at Yuan Ye Urban Design Awards</td>
</tr>
<tr>
<td>2016</td>
<td>IN practice: The state of committed architecture in Europe</td>
</tr>
<tr>
<td>2016</td>
<td>2016: First Prize at Bucharest Triennale 2016</td>
</tr>
</tbody>
</table>
1.4 Chapter summary

Stories have always been used by humans in order to communicate and transfer meaning, and advancements in technology led to new forms of storytelling. The use of multimedia changed the way stories are delivered as it enriched them with new forms of expression.

A story can either be linear, with clearly defined beginning and end, and non-linear. A non-linear storytelling environment, as described above, embodies the convergence of several elements: The use of web, and in particular of Web 2.0 which empowered social interaction, the incorporation of multimedia in traditional storytelling tools, the alternation of different media to complete a story, and the contribution of User Generated Content to it.

When developing a web application, there has to be a clear method for the design and developing process. There are several models that include all the actions necessary for the completion of this process. Some of the most prominent ones are the Waterfall model and the Agile model. The Waterfall model is characterized by a strictly sequential process, while the Agile model has a more continuous and flexible philosophy throughout the project completion. This is the reason why the Agile philosophy was adopted for the particular project.

The SKG parks project deals with the development of a website which aims to provide information about the thematic parks situated across the New Waterfront of Thessaloniki. These parks constitute a particularly successful and popular landmark for the city of Thessaloniki, which is the reason they were selected as a subject.
2. Project Analysis

2.1 Overview of the current landscape

Before embarking on the creation of a website concerning the thematic parks at the waterfront of Thessaloniki, extensive internet research was conducted in order to identify the existence of similar websites on the topic. The research contained searching of relevant keywords and terms in search engines as well as search on popular Social Networking Sites for relevant pages or groups. Specifically, the keywords used in Google and Bing, both in Greek as well as in English, were “Nea Paralia” (New Waterfront), “Paralia Thessalonikis”, (Thessaloniki Waterfront), “Paraka paralias thessalonikis” (Thessaloniki Waterfront parks) and other combinations of relevant keywords. The same approach was adopted in the Social Networking Sites, using the same keywords on Facebook, Twitter and Instagram. The research showed that there was no website dedicated entirely to the Waterfront Parks, apart from a number of features on popular journalistic websites. The only relevant result was a Facebook Page named “Oi Filoi tis Neas Paralias” (Friends of the New Waterfront), which is a club that aims to promote cultural activities and other forms of activism in order to support an experience of collective inhabitation of the public space that the parks occupy. While the Facebook Page is relevant to the topic of the SKG parks project, it does not fall into the same category for two reasons: Firstly, it is a Social Networking Site page and not a standalone website, and secondly, it is focused on the activities of the club and not the actual presentation of the Parks.

From the above information, it is concluded that there does not exist any similar Website that provides information on the topic of the Waterfront Parks, and therefore there is an informational gap that this project (SKG Parks) aims to fill.

As previously mentioned, there does not exist any website that covers the subject of the specific parks of Thessaloniki. Before deciding the content that the website of this project should include, there had to be an online research of similar topic websites, both in Greek and in English. A search was conducted on Google with the search terms “National Gardens”, “National Parks”, and other similar keywords in order to identify websites that dealt with the topic of the representation of such spaces, and more particularly with parks situated in urban environments, such as the parks of Thessaloniki’s Waterfront. The websites chosen to be examined and used as examples of good practice had to contain the following elements: Description of the parks, photographic material, location information and news such as press releases and events.

2.1.1 Related applications: Greek Websites

As far as Greek websites are concerned, we identified two relevant examples:
This website is entirely dedicated to the various parks located in all municipalities of the Athens and Piraeus region. It is operated by the Prefectures of Athens and Piraeus. On the homepage, the main element is an interactive map that includes pin-points of all the parks. Once a pin is clicked on, a pop-up appears that contains the name of the park and a thumbnail photo. On the top left hand corner, a drop-down menu enables visitors to navigate to the park of their preference by choosing either the area or the name of the park. There is also a news and events section where various press releases and upcoming events are posted. Finally, the website contains a forum which is organized by park, where visitors can exchange information.
2. Region of Attica parks

![Region of Attica parks](https://www.athensattica.gr/en/you-are-here/what-to-see/parks)

This case is not a standalone website, but a subdivision of the Region of Attica website. Because of the lack of relevant Greek websites, it is included in this list. The homepage contains a background of an actual photo of one of the parks of Attica. The website is straightforward, offering a list of the parks located in Attica that can be arranged either alphabetically or by popularity. Under the park’s name there is a brief description of it. Once the visitor clicks on the park of their selection, they are transferred to a new page. The new page, which is separate for each park, contains a slideshow of photographs, under which there is an extended description. The description contains information such as the history of the park and the activities it offers. Right under the description there is a list of useful information, such as opening hours, contact details and location and transportation information. The visitors are able to add the parks of their preference to a wish list through a button that is located at the bottom of the page.

2.1.2 Related applications: International Websites

As far as international websites are concerned, there were many to choose from, but the following portray the material we are interested in in the best manner.
1. National Parks UK

![National Parks UK website](http://www.nationalparks.gov.uk/)

*Figure 2.3. National Parks UK. ([http://www.nationalparks.gov.uk/](http://www.nationalparks.gov.uk/))*

This website is dedicated to the 15 national parks of the United Kingdom. Every page of the website contains a header of a compelling image of one of the parks. The website offers two ways to explore the parks: Firstly a quick guide that contains a brief description of the park, along with some photos and some key areas of interest. If the visitor is interested to seek more information on a park, there is a link to a dedicated website for each park separately. There is a special page for students and teachers which provides information such as the history of the creation of the parks, their maintenance and the arrangement of fieldtrips. There is also a section for donations in order to preserve the parks and also a page that contains useful information about visiting and other activities such as camping. On the bottom of the page there are links to all the major Social Networking Sites in order for visitors to share the page of their liking.
2. Les parcs nationaux de France (National Parks of France)

This website is dedicated to the 10 National French Parks. It is one of the most detailed oriented of its kind. It is identified as a portal for the French National Parks. On the homepage, visitors can enjoy a slideshow that displays the name of a randomly selected park along with its name. The website is divided in three major categories: “Discovery”, “Knowledge” and “Actions”. The section “Discovery” contains all the parks, organized by name. When each park is clicked on, visitors are transferred to a page dedicated to it. There is only one photo per park, below which comes very specific information: Date of Creation, location, surface and history. Below that information there is a link to an interactive map. There are separate subsections dedicated to a comprehensive history of the parks, their administration and their organizations. The “Knowledge” section is divided to subsections that contain information about biodiversity, environmental education and protection and preservation. The “Actions” section is divided to subsections that deal with scientific, agricultural, and other actions. It is worth noting that on the footer of each page there are four buttons, one exclusively for photographic material, one for video, one for publications and one for press releases. At the bottom of the footer there is contact information and social sharing links.
2.2 Purpose

The purpose of the SKG Parks website is to provide complete information about the Parks that are situated in the New Waterfront of Thessaloniki, thus filling the informational gap that exists on the topic. This information includes thorough presentation of the parks, their identity, the idea that governs their construction, accompanied by the respective photographic and video material. Furthermore, the website aims to provide location and transportation details for visitors, as well as information on current events taking place at the area of the New Waterfront through a blog that informs visitors about such news. The website aims to encourage visitor participation and user generated content by inviting visitors to contribute with their own content, such as photos, videos, news posts etc. Another aim is to stress the importance of the preservation of the parks and the new waterfront by highlighting the activities of volunteers and groups that help keep the parks clean and beautiful.

2.3 Motivation

The motivation of this project is the re-design and re-engineering of the website that was developed during the “Digital Content Production” course of the Master’s Program “Digital Media, Communication and Journalism” of Aristotle University of Thessaloniki. The aim was to reproduce an improved version of the website created in the course, taking advantage of the experience gained through it. Moreover, we intend to create a good practices guide for non-developers that wish to create non-linear storytelling environments through testing and using multiple tools. Figure 2.5 presents screenshots of the first version of the SKG parks website.

Figure 2.5. Screenshots of the first version of SKG parks.
2.4 Target audience

The website is targeted towards various audiences, regardless of their knowledge of the parks or not. It is not only targeted to citizens of Thessaloniki that can visit the parks for recreation, but also to Tourists planning to visit the city, which is why location and transportation information is particularly important. As mentioned before, there is no other website dedicated to this area, so visitors can learn the story behind each park as well as its special characteristics. For all the above, the target audience of the website is visitors from all age groups that are either interested to visit or have already visited the parks and seek for more detailed information about them.

In order to further identify the user needs and preferences, we conducted a small scale survey. The questionnaire used attempts to investigate the degree in which the targeted users are interested in the creation of a website about the New Waterfront, and the type of content they would prefer to see in it. We also investigated the frequency of internet access, the device used and the interest in the possibility of a UGC platform. We gathered a total of 40 responses from people of various age and education backgrounds, that had already visited Nea Paralia in order to have a knowledge of the project topic. The questionnaire was created with Google Forms and was disseminated by email and link sharing. The following sub-chapter describes this procedure.

2.4.1 Working with Google Forms

Google offers the opportunity to users to easily create online surveys. To start a new questionnaire, we navigated to http://forms.google.com, where we were prompted to log into our account. Once we had logged in, we were presented with the options to either start from a blank page or from a pre-made template. There are several templates available depending on the form needed. We created a blank form by clicking the “+” button on the top left hand corner (Figure 2.6).
Once we had clicked on the button the form building interface appeared. On the top of the form there was a title and description field. A new question was automatically added, which was up for modification. On the right hand side there was a tool menu through which the user can add Titles, questions, images, videos or new sections (Figure 2.7).

Once a question is typed, automatic suggestions come up. For example, when “Gender” was typed in, Google suggested “Male”, “Female”, “Prefer not to say” and “Other” as options (Figure 2.8).
Figure 2.8. Configuring Google Forms questionnaire: automatic suggestions.

The drop-down menu on the right-hand side of the question block lets the user choose the form of the answer. They can choose the form of a short answer, multiple choice, linear scale etc. For the specific question, we selected multiple choice (Figure 2.9).

Figure 2.9. Configuring Google Forms questionnaire: drop-down selection menus.

To add more questions, we selected the “add question” option from the right-hand side vertical menu. This menu can also be used in order to add titles, photos, videos or new sections to the questionnaire (Figure 2.10).

Figure 2.10. Configuring Google Forms questionnaire: add menu options.
Once all the questions were added, we clicked on “send” on the top right hand side corner of the window. In the dialogue that opened, Google offered the options to share the questionnaire through email or link sharing. We shared the questionnaire through email and also copied the link in order to forward it (Figure 2.11).

**Figure 2.11.** Configuring Google Forms questionnaire: share dialogue options.

Once the receivers fill in the questionnaire, the responses are automatically collected and organized into charts and graphs that can be viewed immediately. The number of responses is recorded at the top of the page and they can be viewed either individually or as a summary (Figure 2.12).

**Figure 2.12.** Analyzing Google Forms questionnaires: get responses.
2.4.2 User analysis results

The majority of the participants were female (66.7%), and 66.7% of them were under 30 years of age. As far as the education background is concerned, 60% of them owned a Master’s degree. All the participants stated that they access the internet every day, and the device of preference for most of them was the mobile phone (43.3%), or a combination of desktop/laptop, tablet and mobile phone (46.7%) (Figures 2.13, 2.14, 2.15, 2.16, 2.17).

Figure 2.13. Gender results on user analysis questionnaire.
Figure 2.14. Age results on user analysis questionnaire.

Education level

Figure 2.15. Education level results on user analysis questionnaire.
How often do you use the Internet?

30 responses

- Everyday: 100%

Figure 2.16. Frequency of internet use results on user analysis questionnaire.

What device do you use to access the Internet?

30 responses

- Desktop computer: 8 (26.7%)
- Tablet: 2 (6.7%)
- Mobile phone: 13 (43.3%)
- All of the above: 14 (46.7%)

Figure 2.17. Device of preference results on user analysis questionnaire.

The results showed that 53.3% of the participants would visit a website dedicated to Nea Paralia, while 33.3% might visit it and 13.3% would not visit it. This is a positive outcome as the participants showed interest in the creation of such a website. In the information type question, the majority of the participants (70%) stated that they
would like to see a combination of historical, location and news and events information. As far as content type is concerned, 63.3% of the participants would prefer a combination of text, photos and videos. Finally, in the question about the option for user-uploaded content, 63.3% answered that they would like to have that option. It is worth noting that there were no negative answers received in this question (Figures 2.18, 2.19, 2.20, 2.21).

![Figure 2.18](image1.png)

*Figure 2.18. Visit intention results on user analysis questionnaire.*

![Figure 2.19](image2.png)

*Figure 2.19. Information type of preference results on user analysis questionnaire.*
Figure 2.20. Content type of preference results on user analysis questionnaire.

Figure 2.21. Visitor upload option results on user analysis questionnaire.

The above results show that there is potential interest in the creation of a website about Nea Paralia, which should include a variety of information and multimedia content. It should also be optimized for mobile access as it is a very popular device among the sample.
2.5 Chapter summary

Before starting the design process of SKG parks, we searched the Web for similar topic websites, in order to identify the key elements that needed to be included. Using specific keywords in search engines and social networking websites, we identified good practices, both Greek and international, in order to get inspiration from them.

The main purpose of SKG parks is to provide thorough information about the thematic Parks, in order to fill the informational gap that exists on the topic and the website is targeted to citizens and tourists of all ages that seek more information on the topic.
3. Project and Application Design

3.1 Introduction

3.1.1 The importance of Web presence
As the Web continuously enters our lives and affects it in numerous new ways, having an online presence in the form of a website is considered to be vital, whether it is an individual, an organization, or a small business. The importance of an online presence lies not only on the fact that it reaches an enormous audience worldwide, but also on the fact that nowadays, a website is a benchmark that people refer to when searching for something, and creates a sense of trust.

As the Web progressed through the years, websites became more advanced and went from being text-only catalogue-like pages to providing a full set of multimedia and functions to users. That is why there is great importance in design and service quality of websites. Website quality refers to the layout, the navigation and the overall appearance of the website (McKnight et al., 2002a; McKnight et al., 2002; Cyr, 2008). The form of the interface can have a major impact on the users’ observations and perception of the website’s functions (DeLone & McLean, 1992). Service quality can be defined as the prompt response to visitors’ inquiries and good after sales service (when referring to a business website) (DeLone & McLean, 2004).

3.1.2 Traditional website development vs. website building platforms
Developing a website is a fairly complex process that consists of numerous steps, such as design, development, testing and user experience (Lacko & Ruzicky, 2014). In order to build a website from scratch, one has to have extensive knowledge of coding, building and designing. Nowadays web developing has become feasible for individuals who do not have these skills, thanks to a variety of new options that are offered. These options include open source Content Management Systems and online building platforms.

3.1.2.1 Content Management Systems
A Content Management System (CMS) is a server program that stores web page text and publishing details in a database, rather than in a HTML page. They are very user-friendly and make website building and content management an easy task. The pages are loaded when they are requested by the client browser and are built on demand. CMS help organize and publish content and modify the layout and overall appearance of the website with the use of templates.

The content is separated from the design, which is not the case with hardcoded websites. Changes and additions of content can be performed online and are published in real time. A variety of features and functions can be added to the website by using plug-ins. Compared to a static HTML website, CMS based websites have an increased volume of interactivity (Patel, Rathod & Prajapati, 2011). Popular open-source CMS
include Wordpress, Joomla and Drupal. CMS offer greater flexibility in terms of design and features, but require significantly more knowledge and skills in order to function compared to online building platforms.

3.1.2.2 Online Website building platforms

Nowadays there are numerous website building platforms around that help users create websites without having programming or designing skills or knowledge, and often for a much smaller cost. These platforms provide an easy drag-and-drop interface with additional tools and application, which make the designing process very easy. There is no need for code writing, although if a user has the knowledge they can use it in order to make tweaks and improve the appearance of the website. These platforms usually offer not only the design, but also the hosting and the administration functions. These platforms have come a long way since they started and they are able to provide their users with professional-looking websites. There is a big selection of platforms available in the Web, the most prominent of which are Wix, Squarespace and Weebly.

3.1.2.2.1 Squarespace

Founder Anthony Casalena started working on Squarespace out of his dorm room in 2003, and the company was launched in January 2004 and is now headquartered in New York with offices in Portland and Dublin. Squarespace has more than one million paying customers on the platform. The company’s mission is to create beautiful products to help people with creative ideas succeed. Squarespace allows users to customize and develop a fully operational website by using templates, images and fonts.

Squarespace offers significantly less templates than Wix, but they are designed by professionals and are very carefully crafted with a clean and minimalistic touch that create a sophisticated look. The templates are mobile responsive by default, which is a great advantage as mobile devices are rapidly gaining even more popularity, and of great importance to businesses that aim for mobile device users. As far as customizing is concerned, Squarespace provides a style editor that enables custom styling without having to edit code, so that each element of the website is displayed according to the user's preference, from background images to fonts, colors and page configurations.

Unlike other popular website building platforms, Squarespace does not offer a free plan, which means that, in order for a website to be published, the user has to purchase one of the paid plans, which vary from low prices to all inclusive high price packages.

3.1.2.2.2 Weebly

Weebly is an online website building platform that started in 2006. It features one of the easiest to use drag and drop builders, that contains all the basic tools without
overwhelming the user. Advanced tools are constantly introduced, but always within the concept of facilitating beginners and non-programmers to use them without problems. Weebly, as the aforementioned platforms, offers professionally made templates. All templates are responsive and come with pre-made page layouts for various sections that websites of all types use, such as Home, contact page, etc.

Weebly offers the additional ability to access the html and css code behind them, giving users the opportunity to further customize their websites if they have such knowledge.

The downside is that the user cannot make many alterations through the editor, which limits the tweaks to color schemes and fonts, and further customization can only be done by altering the code.

**3.1.2.2.3 Wix**

Wix is a free tool that allows users to develop or adapt their own websites using content of their choice. It gives users the opportunity to create a powerful and user friendly website by giving complete control and flexibility without demanding a knowledge of coding or web designing.

Wix is the leader in the field of online website building platforms, owning an impressive 90 million users, which puts them in the first place as far as market share is concerned. It was founded in 2006 and started as an Adobe Flash based platform. As technology advanced and Flash elements were gradually phased out, it introduced its HTML5 editor in 2012.

Wix offers its users a very large selection of templates, which cover the needs of almost all types of websites. It provides an easy, drag and drop WYSIWYG online editor, with a separate mobile editor for mobile sites. It includes a large selection of integrated custom fonts, that allow further customization of websites. Apart from free file hosting, it also offers an advanced image editor that simplifies even more the procedure of image editing for users that do not have the appropriate skills. Users can also connect their domain names and add blog modules. Through its app market, users can enrich their website with more features such as social widgets that enable interaction, including all major Social Networking Sites, marketing tools such as newsletters and coupons, shopping carts for commercial websites and online reservation tools. User support is provided 24/7 and its services come either in a free plan which uses a Wix banner for advertising purposes or various paid plans depending on the customer needs.

While it offers the richest set of features for the modification of the created website, Wix does not allow the change of templates after the website is created, so the user has to be very careful when setting up their website.
3.2 Design Basics

Website design is very important to the success of a website. The interaction produced when browsing the Web constitutes a cognitive experience that involves perceptions and preferences. This means that users not only perceive the Web as a landscape, but also enter it and experience it. In this sense, elements such as color schemes, distinctive graphics and site maps that make browsing more straightforward enhance positively this experience.

Website design should be user friendly, which means it should be easy to understand and use. Information overload should be avoided, as minimalistic design not only makes the website more appealing, but it also makes it faster. Another important design value is to produce a website that is unique and distinctive. A website with a strong identity is more likely to attract visitors and be memorable to them (Rosen & Purinton, 2004).

Hasan (2016) points out that design components such as information, navigation and visuals offer opportunities for interaction to visitors, based on which they form their opinions on their online experience. Content, structure and functionality capture the essence of this interaction. Hasan (2016) proceeds to divide design into three categories: Visual Design, Navigation Design and Information Design.

Visual design refers to the aesthetics and its appearance, including colors, images, fonts and layout. Visual design is an important measure of quality on a website and directly affects user experience. Visual design has the ability to convey positive messages to visitors and enhance their beliefs about the website.

Navigation design refers to the structure and organization of the website's content. An efficiently designed navigation system should allow users to easily browse the web pages of their desire with minimal effort. Complicated and overwhelming navigation with unnecessary screens or options has a negative impact on visitors and causes them to lose sense of location, which can result to them leaving the website.

Finally, information design refers to the delivery of relevant information to visitors. The availability of current and easy to understand information enhances visitors’ satisfaction.

3.2.1 Visual Hierarchy & Page layout patterns

When producing web page material, it is important to keep in mind that there are certain guidelines that apply to the design, thus creating new ways of arranging content instead of repurposing what would apply for print content. This means that visitors scan a webpage in a certain manner, and content should be arranged appropriately.

The concept of Visual Hierarchy is vital for web design. Visual hierarchy is the order in which our eyes follow when they recognize what they observe (Eldesouky, 2013). When dealing with a webpage, we can refer to Faraday’s (2000) research findings, where he mentions variables that influence Visual Hierarchy. Such variables are images, size, position and text style.
The way people read through a webpage design leads to the emergence of some layout patterns that are recommended in order to take advantage of this behavior. All cultures read from the top down, and the majority of cultures read from left to right. Most Western readers in particular will begin from top to bottom and left to right. With this as foundation, several patterns emerge that most websites follow in order to improve their usability and user experience. The three most popular layout patterns are the Gutenberg diagram, the F-pattern and the Z-pattern.

3.2.1.1 The Gutenberg diagram

The Gutenberg diagram applies best to text-heavy, homogenous and evenly distributed content and cannot be applied to every design. It divides the layout in four quadrants: The primary optical area which is located in the top left, the strong fallow area, which is located in the top right, the weak fallow area which is in the bottom left and finally the terminal area which is in the bottom right. It also suggests a path that the eyes follow, which is called “reading gravity”, which is a movement from the primary area to the terminal area. According to the Gutenberg diagram, important elements should follow the gravity path, as information outside it receives minimal attention, unless there is strong visual attention to them (Eldesouky, 2013).

3.2.1.2 The F-pattern

In an eye tracking study that was performed by Nielsen in 2006, it was observed that most visitors had a consistent viewing behavior when visiting various websites. Their scan pattern showed that there were three main components:

1. The first scan is done horizontally, across the upper part of the web page.
2. The next is a short downward scan followed by a second horizontal scan, typically shorter than the first one.
3. The final movement is a vertical scan that is usually slower and more focused to detail.

This scan pattern, which was observed in the study and tracked in a heatmap, showed that the visitors’ reading behavior on a webpage creates a shape that resembles the letter “F”, thus creating the “F pattern” for arranging web content, which is used by numerous websites (Nielsen & Norman, 2006). According to this pattern, the most important information should appear at the top area of the design, as it will definitely be read. Lesser information should appear at the left side.

3.2.1.3 The Z-pattern

Another popular pattern for arranging content is the Z-pattern. This pattern resembles, as expected, the letter “Z”. Visitors start at the top left, make a horizontal scan to the top right, followed by a diagonal movement to the bottom right and finally another horizontal scan to the bottom right. The Z-pattern is a good choice for designs that are simple but have some special key elements that need to stand out. Storytelling elements of the website also follow the Z pattern (Eldesouky, 2013).
These patterns represent a general conception of the way the eyes move through the designs we create, which leads to the creation of a Visual Hierarchy.

Even though these patterns are intended to be used with text-dominated designs, where there is little hierarchy, they can also be used as rules that help us decide where to place important information or elements, in a manner that leads the path of the visitor’s eye (Eldesouky, 2013). Of course elements with big visual weight have the ability to alter these patterns, as they create their own Visual Hierarchy, but the aforementioned patterns do serve as a general guideline to keep in mind when designing a webpage.

3.2.1.4 Colors

The color scheme is a very important part of website design, as it is one of the first elements that create the overall impression. Colors can elicit certain emotions and behaviors, which have an impact on the trust and satisfaction of visitors (Cyr, Head & Larios, 2010). Color theory refers to “the interaction of colors in a design through complementation, contrast and vibrancy” (Cannon, 2012).

Complementation refers to the way the human eye can see colors in terms of their relationship with other colors. Colors that belong to the opposite ends of the spectrum that are matched together are more appealing to the viewers. Their matching provides balance and that is the reason why they are called “complementary colors”.

Contrast refers to the level of clarity between two elements on a page, for example text and background color. The most usual practice is to use a lighter background with dark colored text. Using a different color for a particular portion of the page can help draw the focus of the visitor.

Vibrancy refers to the feelings that each color elicits to the viewer. Brighter colors add an energetic vibe to the design, while darker colors invoke relaxation.

There are several methods for the selection of a color scheme, such as the Triadic Color Scheme, the Compound and the Analogous. To facilitate this process, there are several tools that make use of the theory and help web designers choose an effective color scheme, such as Paletton (http://www.paletton.com), Adobe Kuler Color wheel (http://color.adobe.com) and Coolers.co (http://coolors.co).

3.3 Working with Wix

3.3.1 The Platform

The platform that was selected for the development of the website is Wix. From the comparison of the three major building platforms that are described in chapter 3.1.2.2, it was concluded that Wix is the best fit for creating a non-linear storytelling environments. This is because it offers the largest selection of templates, it provides the biggest customization capabilities and it allows the addition of more sophisticated
features from its app market. For a non-developer it is important to be able to add as many features as possible without having to add code, and Wix is the best out of its competitors at this matter.

3.3.2 Getting started

The first step when visiting [www.wix.com](http://www.wix.com) is to create an account. There is a “start now” button at the Wix homepage prompting the user to do so. Signing up is a quick procedure, as it only requires a name, an e-mail and a password. There is also the option of Facebook or Google account linking (Figure 3.1).

![Figure 3.1](image.png)

*Figure 3.1.* The Wix homepage where the user has to sign up for a new account or log in to an existing one.

Once the user account is set up, Wix prompts the user to choose the kind of website they want to create. There is a variety of categories such as business, blog, portfolio, events etc. If the user feels that their website does not fall in any of these categories, there is the “other” option (Figure 3.2).
The next step is for the user to choose the template they want to build their website on. As mentioned before, Wix offers the largest selection of professionally designed templates. There are over 400 templates organized by website type. If the user feels limited by the pre-made templates, Wix also offers a selection of blank templates (Figure 3.3).

![Figure 3.2. Wix environment: the page where the user has to select the type of website to be created.](image)

![Figure 3.3. Wix environment: the page where users select a template to start with.](image)
At this point, as mentioned before, the selection of the template must be thoughtfully decided, as templates cannot be switched once the website is created.

The templates are fully customizable, so even if a template does not seem to initially be a perfect fit for the intended project, it can evolve to be whatever the developer wishes. For the particular project, the template chosen was “Home Décor”, which is usually used to create ecommerce websites, but it served as a good inspiration point design-wise so it was selected as a foundation for SKG parks.

Once the preferred template is selected, the user is presented with the building interface (Figure 3.4).

![Wix environment: the building interface once the template has been selected.](image)

Figure 3.4. Wix environment: the building interface once the template has been selected.

As the user enters the building interface, there is a number of tools and menus, each serving a different purpose.

3.3.3 The Left Menu

The menu on the left side of the editor, is used for adding and editing elements on the page.

More specifically, there are 7 options:

1. Background: This tool is for changing the page background, either with a color, an image or a video.
2. Add: This option is used to add elements to the website, such as text, images, galleries, buttons, videos, music, menus etc.

3. App Market: Wix’s app market can be used to enhance the website with a selection of apps that add more functionality. Many of these apps work with external sites. There is a variety of free and paid options and the categories include design tools, chat apps, booking, business and marketing tools.

4. My uploads: This tool is used to upload images, music and other documents to the Media Manager that Wix offers. This tool helps the user to maintain an online gallery of documents that are accessible from anywhere, which makes it easier to add material to the website. Apart from the user-uploaded content, Wix offers a selection of free media which can also be used.

5. Blog: This tool helps the user manage blogs on their website.

6. Promote: This is a tool for creating new and editing existing newsletters in order to promote the created website (Figure 3.5).

![Figure 3.5. Wix environment: The left menu which is used for adding or editing elements in the page.](image)

### 3.3.4 The Pages Menu

On the top bar menu of the editor, there is the Pages menu, which is used to manage the site’s pages. The user can add, rename and reorder pages, set the homepage, create subpages and manage page permissions. There is also an option to add a landing page and change the page transitions (Figures 3.6 & 3.7).
3.3.5 The Editor Toolbar

On the right side of the editor, there is another set of tools, the Editor Toolbar. It can be used to edit separate elements on the website. It contains a variety of options that get activated when the user selects an element on the page, i.e. a button. Then, they can select to copy, paste, duplicate, delete, arrange, align, rotate or adjust the size of it. For convenience reasons, the toolbar can be hidden at any time (Figure 3.8).
Figure 3.8. The editor toolbar, which is used to copy, paste, delete or duplicate elements.

3.3.6 The Right-click Menu

There is also a menu that shows up when the user right-clicks on the page, which is different depending on the type of element that is clicked on. This menu generally includes options such as copy and paste, show on all pages, arrange, duplicate and delete. As mentioned before, element-specific options are also available, so if for example an image is clicked on, there are also design, crop, image filter, animate and link tools (Figure 3.9).
NON-LINEAR STORYTELLING ENVIRONMENTS

*Figure 3.9. Wix environment: The right-click menu that is prompted when the user right clicks on an element.*

3.3.7 Gridlines
Across the editor page, there are several gridlines that divide the page into three sections:

The Header, which is located at the top of the page and appears in all the website’s pages. This is the part where usually the logo and menu are situated.

The Page body, which contains the main content and is usually different in each page. The page body is further divided into subsections in order to be easier to arrange elements and spacing.

The footer, which is located on the lower part of the page, and similarly to the header, appears throughout all the pages (Figure 3.10).

*Figure 3.10. Wix environment: the gridlines that divide the page into sections for editing.*

3.3.8 Site Manager
Creating a website is not limited to its design and development, but also needs effective management. In the Site Manager page of Wix, the owner of the website can
perform many actions that are vital for a successful web presence. The Site Manager lets the owner:

- Rename, transfer, delete or duplicate the website
- Connect a domain
- Upgrade to paid plans
- Perform Search Engine Optimization in order to be ranked by search engines such as Google
- Enable mobile view
- Change Language and region settings
- Modify social sharing settings
- Use analytics to observe the website’s performance
- Invite contributors to co-edit the website and modify their permissions (Figure 3.11).

![Site Manager](image)

*Figure 3.11. Wix environment: The site manager.*

### 3.4 Thematic Categories and Pages

As we mentioned before, the main purpose of the project website is to inform local and tourists about the parks. In order to do this, the website needed to include certain information which should be organized in the respective pages. The organization of the pages must provide an easy navigation and a clear division between the categories. The core of the website must include the following pages:

#### 3.4.1 Homepage

The homepage should be designed with the idea to illustrate to the visitor an overview of the whole website, while at the same time providing quick navigation to the major categories. We decided that it should include a rich photographic element in order to give a dynamic first look at the Parks environment and draw the interest of the visitor.
3.4.2 The Parks
The page that is going to be dedicated to the parks is essentially a page that serves as a transfer point to the individual Park description pages. The visitor should get an overview of the total of the parks and their names and easily navigate to the park of their preference.

3.4.3 Individual Park Page
These pages (13 in total) are designed to provide the biggest amount of information. They will serve as a presentation of each of the parks with detailed text and images. As mentioned before, they are designed to include a combination of historical and architectural facts as well as ambient elements and ideas for activities.

3.4.4 Video Tour
Video is an essential part of multimedia content. The Video Tour page will contain a compilation video of the parks that was created for the specific project. It is designed to capture the landscape and the atmosphere of the parks.

3.4.5 Location and Transportation
A very useful piece of information that was included in all relevant websites that served as inspiration is the location and means of transportation that is used for the point of interest. Therefore, there should be a page dedicated to serve this purpose. This page will include the location of each park on a customized map for easy reference. It will also include the public transportation that can be used in order to reach the area as well as the respective timetable.

3.4.6 Blog
Apart of the description and location information, visitors should be informed about news ad current events too. A blog can present all this information and also serve as a point of reference for repeating visitors. The blog will contain pieces about upcoming events and also coverage of them after they have taken place.

3.4.7 Contact
Visitors should be able to interact with the project team in order to report mistakes, give feedback or ask questions. A contact page should give them the opportunity to do so in an easy and effective manner. It is important for us to create a channel of communication with visitors as the information exchanged can help us improve our project.

3.4.8 Navigation Plan
Based on the above, Figure 3.12 presents an illustration of the navigation plan for the basic categories of the website.
Figure 3.12. The navigation plan that illustrates the basic pages of SKG parks.

3.5 Chapter summary

The design process is very important, as it sets the foundation for the development of the website. When designing the project, we took into account several design theories that are fundamental in web design, such as Visual Hierarchy, layout patterns and color theory. After selecting the development tool, Wix, we took time to understand its tools and functions in order to be able to take advantage of its possibilities. After that, we designed the structure of the thematic categories and pages in order to have a clear vision of the desired outcome and start the development phase.
4. Project Development

4.1 Working with prototypes

Developing prototypes is a very important stage in the development process, as it helps the demonstration of the proposed interface and helps gain insight and get feedback regarding the functionality and design of the website (Carmer et al, 2015)

A prototype is a working model of the proposed website built in order to develop and test ideas. Prototyping is used in web building to examine content as well as aesthetics and interaction and can be tested by both designers and targeted users. There are many techniques for prototype making, and the level of their functionality and detail classify them as low fidelity or high fidelity prototypes. A low fidelity prototype is a representation that can be designed either by sketching on paper, or by choosing an appropriate software tool. Its production is quick, therefore leaving time to focus on interaction and information architecture rather than visual details. High fidelity prototypes are very close to the final product, and often include the same appearance and interaction techniques, which means they are more time consuming and costly to produce. Research has shown that low fidelity prototypes are more effective, as they allow designers to concentrate on information and interaction architecture while minimizing cost and saving time (Walker, Takayama & Landay, 2002)

4.1.1 First Prototype

The first prototype made for the project was more of a design inspiration mockup and less of an actual function representation. It was designed in Adobe Photoshop and included a full screen graphical representation of the location of the parks, with a location pin representing each one of them (Figure 4.1). This graphic would also ideally contain the starting point, which is the White Tower, and the ending point, which is the Concert Hall, as well as the exact geographical location of each park. Below the graphic there would be a menu with a link to a compilation video, an info section and a social sharing link.
When each location pin would be clicked on, a pop-up would appear on the same page, which would contain a small image gallery of each park, the location on a map, a small description including a tip for visitors and some social buttons for sharing the content, such as Facebook, Twitter etc. (Figure 4.2).

This prototype was created with the idea of an innovative website interface that would be based on bold graphics, rather than the classic webpage structure. After revision, it was decided not to proceed with the particular design, as it would require exceptional coding and designing skills and also use of more sophisticated tools. The aim of this...
The project is to demonstrate how non-programmers can develop an adequate and successful website, so a new prototype had to be made.

4.1.2 Second Prototype

The second low fidelity prototype was created with Mybalsamiq (http://www.mybalsamiq.com). Mybalsamiq was a tool that was proposed in the Digital Content Production course, and was adopted because of its simple interface that helps beginners create prototypes. Its sketch-based prototypes are good for focusing on functionality, and since developing with platforms has a degree of unpredictability that lies on their limitations, it is the best choice.

Mybalsamiq, which is an online version of the Balsamiq software, is a tool for creating mockups from wireframes to clickable prototypes (Henitz et al, 2014). It offers an easy to use drag and drop interface that includes a variety of elements, such as blocks of texts, images, buttons, scrollers etc. Mybalsamiq also supports collaborative design in order to instantly get feedback and revisions. While it has a paid option, it also offers a 30-day trial version to use for free.

The homepage (Figure 4.3), following the Visual Hierarchy guidelines mentioned above, and in particular adopting the Z-pattern, contains a navigation menu at the top center of the page. Right above the navigation menu there is a small space reserved for the website logo. The menu contains four categories: The parks, Virtual Tour, Blog and Events. In the main space under the menu, there are several thumbnails each representing one park, that, when clicked, transfer the visitor to a new page with detail description. On the right side there is a sidebar that contains a summary of the blog posts at the top, under of which is situated a calendar for the marking of current and upcoming events in the parks.
**Figure 4.3.** Prototype made with Mybalsamiq that depicts the homepage of the project.

Figure 4.4 represents the page that contains the detailed description of each park. On the left side, there is a photo gallery. A big scaled image is situated at the top, under which there are more thumbnails that can be clicked on in order to view the full-size photo. On the right, there is a space reserved for text, which will contain a brief description, history, and other important information. There is a link on the top left corner which leads to the previous page in order to make navigation easier.

![Prototype made with Mybalsamiq that depicts the homepage of the project.](image)

**Figure 4.4.** Prototype that was made with Mybalsamiq that represents a page of a park description.

Figure 4.5 presents the design for the page that contains the “Virtual Tour”. The virtual tour is a compilation video that will serve as a tour, and includes shots from all the parks and the surrounding area, thus highlighting not only the scenery but also the atmosphere of the space. The page is minimal and straightforward, placing in the center of attention a player for the video tour.

![Design for the page that contains the “Virtual Tour”.](image)
4.2 Gathering the Material

4.2.1 Texts

The texts used in the descriptions of the parks include information from Greek websites. One of main the sources was the website of the Municipality of Thessaloniki (http://bit.ly/1ToOrRh) and also the official website of the architects in charge of constructing the parks on the new waterfront (http://bit.ly/1To1u3A). Additionally, we conducted an interview with the architects, which we transcripted in order to draw more information. The information was adjusted to the form we needed and then translated by us in English. Next, the texts were proofread in order to be accurate and avoid any language mistakes.

The idea was to provide through the texts the basic information about the things a visitor can see in the parks, their purpose, their location, and their characteristics. The texts contain some elementary architectural facts, the surrounding, the vegetation of the park, the possible construction, as well as specific areas (playgrounds, pet walking places, courts). They intend to instigate the visiting of the parks and their preservation.

The texts in the website are located mainly in the individual park pages, they are short, approximately 50-100 words, depending on the information we could provide. Besides the general information they also contain some of our own impressions after visiting them. Our goal was to emphasize the beauty of the nature and exclude unnecessary details. The purpose of the website is to provide data, to ease the orientation and most importantly to promote Thessaloniki as a city and specifically the new waterfront through encouraging tourists and citizens to visit these sights.
4.2.2 Images

The images that are published on the website are all captured by the project team.

The camera used a Canon 600d DSLR with an 18-55mm f/3.5-5.6 IS II lens. Images captured were stored in JPEG form, with a resolution of 2592 x 1728 at 4.5 megapixels, but for faster loading purposes they were resized using Adobe Photoshop to a 1296 x 864 resolution. Additional images were captured with an iPhone 6 smartphone.

In order for the colors to be enhanced, the images were edited with Adobe Photoshop. The pictures were taken from different angles and perspectives, to present properly and give an idea of the environment to the visitor. The images were then uploaded through the Wix platform and organized in albums.

4.2.3 Video

For the video capturing, initially the same Canon 600D camera was used. After reviewing the content on the computer, it was discovered that the video files were particularly “shaky” and therefore they were inappropriate to use in the compilation video. The second time we captured our video content we used an iPhone 6, and also a Samsung S4 smartphone.

The video compilation was done Windows Movie Maker. The videos were cut in smaller segments, and then they were combined using various effects. Music was also added in order to cover the natural sound of the video and make it more enjoyable.

4.2.4 Logo

The logo of the website (Figure 4.6) was designed in Adobe Photoshop. In our planning, it was decided that it should be minimalistic and representative of the project. The logo created is a graphical representation of the promenade that covers the Waterfront Parks, with the iconic monuments that stand at the ends of it. On the left, there is the White Tower, where the promenade starts, followed by a straight line that represents the coastline, which leads to the Thessaloniki Concert Hall, which is where the parks end.
4.2.5 Customized Location Map

Google Maps offer the option to create customized maps. On [http://maps.google.com](http://maps.google.com), once the user has signed in their account, they can select Your places → Maps → Create Map. We pin-pointed the location of each park by using the “Add marker” button and marked each one of them with a different color (Figure 4.7).

![Figure 4.6. The logo for SKG parks.](image)

![Figure 4.7. Customized location map made with Google maps.](image)

After the map is complete, the user can embed it on the website of their preference by clicking on “Embed on my site”, which provides the code for this purpose (Figure 4.8).
Figure 4.8. Google Maps: dialogue with code for embedding.

4.3 Development with Wix

4.3.1. Getting started

The first action that is needed when developing a website with Wix is to select a template. We chose the “Home Décor” template because it suited our needs design-wise. The first action was to delete all the sample content it contained so as to have a neutral environment to start building the homepage (Figure 4.9).
4.3.2. Header

The next step was to stretch the header height, so as to be able to include both the logo and the navigation menu. To do so, we used the stretch handle on the right, which appears when the mouse is located at the header area (Figure 4.10).

When the header area is right-clicked on, a header menu appears that lets the user customize the header design. We selected Change header design → Customize Design → Fill color & opacity to change the color. We wanted an option that is vibrant, which at the same time represents the green of the parks but also with elements of blue that represent the proximity to the seafront. For the above reasons, we chose the color with hex code #28B2A4 (Figure 4.11).
4.3.3 Logo

The next step was to add one of the most prominent elements of the website: The logo. To import the logo image file, we selected the “add” option from the left menu, which is represented by the + symbol, and selected Image → My Image uploads. This option prompts a window that allows users to upload their own images and create galleries to be used in the website, and also use pre-loaded images from Wix. There is the additional option to import images from the user’s social accounts (Figure 4.12).

Figure 4.11. Wix environment: the header design dialogue for changing the color of the header.

Figure 4.12. Wix environment: the gallery that contains user uploads and pre-loaded images.
NON-LINEAR STORYTELLING ENVIRONMENTS

From the user uploads, we selected the logo file and clicked “Add to Page”. The image by default is placed on the center of the page, so it had to be moved to the header, and automatically the option “Attach to header” was available for selection. After some resizing and repositioning, the logo was placed at the top of the header (Figure 4.13).

![Wix environment: the header after the logo was placed.](image)

*Figure 4.13. Wix environment: the header after the logo was placed.*

4.3.4 Homepage

To add the navigation menu, we selected Add → Menu, where the user is presented with a selection of menu designs. With the drag and drop method, the navigation menu is added on the location of preference. New pages added to the Pages menu, automatically appear on the navigation menu as options, unless otherwise selected by the user (Figure 4.14).

![Wix environment: the header after the logo was placed.](image)
NON-LINEAR STORYTELLING ENVIRONMENTS

Figure 4.14. Wix environment: the header after the navigation menu was added.

The gap between the logo and the navigation menu was left in order to put the website title. To do so, we selected Add → Text → Site Title and chose one of the pre-styled text samples (Figure 4.15).

Figure 4.15. Wix environment: the header after the website title was added.

As mentioned before, we decided to put a slideshow on the homepage. To add the slideshow, we selected Add → Gallery → Full Width Galleries → Showcase strip. This option adds a slideshow with pre-loaded images that the user can change with the images of their preference by loading once again the gallery window which contains the user uploads. Width, height and position can be done by using the drag and drop method. Further customization such as auto play settings and playback speed can be done by clicking the settings icon (Figure 4.16).
4.3.5 Footer
The next element that was added to the homepage, which is the same for all pages, is the footer. The template already included a colored strip as a footer with some sample text, so at this stage we just changed the color (Strip → Design → Customize Design → Fill Color and Opacity) and added our own text (Text → Edit Text) (Figure 4.17).

At this stage, this is the first version of the homepage. It does not contain any more information as the rest of the pages are not built yet.
4.3.6 The Parks

The next page we built is the “The parks” page. To add a new page, the user must select the “Add page” button from the Pages menu at the top left hand corner.

As mentioned before, each park has its own dedicated page, but there needs to be a page through which the user can navigate to the park of their preference. For this reason, we created numbered thumbnails in Adobe Photoshop for each park. These thumbnails were then arranged in a gallery and the name of each park was put under the respective thumbnail. To complete this action, we selected Add → Gallery → Grid. Through the settings we changed the default images with our numbered thumbnails. The gallery feature provides the option to assign a link to each picture, where we linked the individual page for each park. Finally, we put the text description under each thumbnail for easier navigation (Figure 4.18).

Figure 4.18. Wix environment: the parks page after adding the thumbnails.

4.3.7 Individual Park pages

For the individual park pages, we combined some of the features that Wix offers.

We added a block of text for the description (Add → Text → Paragraph) on the left-hand side. Then we added a gallery with a clickable slideshow and thumbnails (Add → Gallery → Slider Galleries → Thumbnail), into which we loaded our images. We completed the page with a title for reference (Add → Text → Page title) and a button that returns the visitor to the landing page of the parks (Add → Button → Themed buttons) (Figure 4.19).
The Garden of Alexander is situated in the area surrounding the iconic statue of Alexander the Great. It is the largest one of the parks. It is created through the unification of three smaller parks, diverse in their organization, with trees, paths, bridges and fountains, which create a vibrant atmosphere. The shaft that leads to the statue has been built in a way that creates a striking background for the sculpture - a real benchmark of the coastal front.

Figure 4.19. Wix environment: an individual park page and the elements that were added in order to create it.

The same process was done for the remaining parks.

4.3.8 Video Tour

For the Video tour page, we chose to change the background color to create a more relaxing atmosphere that draws the visitor’s attention directly to the video (Right click → Change Page Background → Color). To add the video, we selected Add → Video → Single Video Players → Vimeo. From that point, the only change that needed to be done was to copy the uploaded video’s link on Vimeo to the settings dialogue (Right click → Video settings) (Figure 4.20).

Figure 4.20. Wix environment: the embedded video in the video tour page and its settings.
4.3.9 Blog

The next addition to the website was the blog page. In Wix it is very easy to create a blog (Add → Blog → Recent Posts). Customization of design such as colors, fonts etc can be done with Right Click → Design (Figure 4.21).

![Figure 4.21. Wix environment: The blog page and the menu for managing the posts.](image)

The management of the blog, such as the addition of new posts, does not take place in the editor. To manage the blog, the user must navigate to Site → My Dashboard → Blog → Manage Blog (Figure 4.22).

![Figure 4.22. Wix environment: the page that is used for managing the blog.](image)
4.3.10 Location & Transportation

Another important element that needed to be included was the location and transportation information. We wanted to pin-point all the parks in a map and include it in a separate page.

We created a customized map on Google maps and then added it to the page by using Add → More → HTML & Flash → HTML Code. We used the HTML code that Google maps provides when creating a custom map. In addition, we added some information about transportation in a text box (Add → Box and Add → Text) (Figure 4/23).

![Figure 4.23. Wix environment: the location and transportation page after adding the map and bus information.](image)

4.3.11 Contact

Finally, the last page that was created was the “Contact” page, which would let users communicate with us. For this purpose, we wanted to include a contact form.

To do so, we selected Add → Contact → Contact Forms. In the settings dialogue of the contact form, the user can set the email for receiving the messages, the information that appears on the form. The design elements such as colors and fonts can be changed by right-clicking on the form and selecting “Design” (Figure 4.24).
Figure 4.24. Wix environment: The contact form added in the contact page and its settings menu.

The development of these pages completed the core of our website. More pages can be added after revision of the content in order to fulfill the project’s purpose.

4.4. Mobile Version

4.4.1 Motivation

Mobile technology has dominated our life in the last years. Mobile devices are used to perform sophisticated tasks, thanks to advancements of technology. Device prices have been lowered while at the same time telecom companies have been offering better voice and internet connection services. The combination of these facts has led to the soaring of the mobile market size worldwide (Sanakulov & Karjaluoto, 2015).

Mobile devices have changed the way individuals consume and share content. Their success lies in the fact that users get intent-driven interactions in real time. Applications on mobile devices take advantage of their technologies in order to deliver communication, productivity and entertainment services.

The widespread of mobile devices and the opportunities that their technology offers motivated us to create a mobile version of our project. This version was developed only as a prototype, as the actual realization of it falls outside the limits of the Web building platform we chose.

4.4.2 Working with the Invision platform

To create the interactive prototype, we used Invision (http://www.invisionapp.com). Invision is an online product design collaboration platform that can be used to create functioning high fidelity prototypes. The prototypes can be either collaboratively
NON-LINEAR STORYTELLING ENVIRONMENTS

designed in real time or shared in order to get valuable feedback that can be used for further work.

Invision was selected because, aside from its strong collaboration features, it presents the result as a functioning web page rather than a pdf file. This way the target user can get a better grasp of the proposed environment and is able to evaluate it effectively.

The first step was to visit [www.invisionapp.com](http://www.invisionapp.com) and log in to our account (Figure 4.25)

![Figure 4.25. The Invision homepage.](image)

The next step was to create a new project. This is done by clicking on the “+” button on the top right hand side corner of the page (Figure 4.26).
Figure 4.26. Invision interface: the projects page were existing projects are displayed and the new project button.

The next step is to choose the type of project to be created. We chose “prototype” (Figure 4.27).

Figure 4.27. Invision interface: the project type selection page.

The next step was to choose a name for the project and the device it is designed for. We named it “SKG parks” and chose the iPhone device, since it is a popular option among mobile phone users (Figure 4.28).

Figure 4.28. Invision interface: the project name and device type selection page.
Once the device was selected, we were asked to import the image files for the screens of the prototype. In our case, the images were created in Adobe Photoshop and were uploaded from a personal computer. InVision supports a variety of formats such as .pdf, .png, .jpg etc. as well as syncing projects from Sketch or Photoshop (Figure 4.29).

*Figure 4.29. InVision interface: the page where screen for the prototype are imported.*

Once the images are uploaded, the user can view them, re-arrange them and set one of them as a loading screen (Figure 4.30).

*Figure 4.30. InVision interface: the page where the screens of the prototype are displayed.*
Once we selected an image, we chose “build mode” from the bottom bar menu in order to add clickable hotspots. By selecting an area with the mouse, a hotspot is created, which is then assigned to a target destination. This process was repeated for all the screens of the prototype (Figure 4.31).

![Figure 4.31. Invision interface: the build mode where interactions are added.](image)

After all the screens were ready, we used the sharing link on the top right hand corner of the screen, in order to let other users view the prototype and gather feedback (Figure 4.32).

![Figure 4.32. Invision interface: the button and dialogue for sharing the project.](image)
We also used the collaborative function of Invision, which is Liveshare, in order to evaluate the prototype. To trigger Liveshare, we clicked on the thunder icon on the top right hand side corner of the screen (Figure 4.33).

![Figure 4.33. Invision prototype: the button that triggers Liveshare.](image)

In Liveshare, users that are invited can sketch, type, and chat in real time in order to propose modifications and ideas. Each user is represented by a different color and there is also a group chat box in the bottom left hand side corner to facilitate communication (Figure 4.34).

![Figure 4.34. Invision interface: the Liveshare mode screen for collaborating.](image)

The evaluation of the prototype is described in chapter 5.3.
4.4.3 The mobile application version Interactive Prototype

For the future development of the website, we have created a high-fidelity prototype for a mobile version. While Wix offers responsive templates, it does not support advanced features that we would like to incorporate in the mobile version, therefore this prototype presents a theoretical version of it.

The main aim of the mobile version is to incorporate most of the material found on the desktop site, while offering a special platform where users can contribute with their own content. The idea is to provide a participatory role to the users in order to enrich their experience and be part of the storytelling.

The prototype was created with Adobe Photoshop and Invision, a tool that is described in detail in chapter 4.4. Firstly, the screens of the user interface were designed one by one in Adobe Photoshop. Then they were uploaded to the Invision platform, where they were combined into a live prototype. Invision is an online platform for designing and sharing interactive prototypes. It enables collaboration by providing the opportunity to receive and exchange feedback and comments.

As mentioned before, the mobile version contains most of the features of the desktop sites, such as the presentations of the parks, the video tour, the blog and the transportation and contact pages (Figure 4.35).

![Figure 4.35. Indicative screens of the mobile version.](image)

The prototype of the mobile version also contains a platform where users can upload their own media content (photos and video), along with tags and comments in order to create engagement. This material is then added to a user generated gallery. Users can
then comment on the content. The platform can be found under the section “You@SKGparks”. When clicking on it, the user has two options: To view the gallery or upload their content (Figure 4.36).

![Mobile version: the you@SKGparks page.](image)

The gallery is organized by latest addition and is presented as a series of thumbnails. There is space for a few tags under the thumbnail, but the full description appears once it is clicked on (Figure 4.37).
When clicked on, the photo opens in a new tab, under which there is a commenting system (Figure 4.38).
For the submission of content, after the user has clicked on “Submit your own” a new tab opens. The user chooses the file of their preference, and fills in the “tags” and “description” boxes. Finally, they click on “submit” and the content is uploaded (Figure 4.39).
After the content is uploaded, the user is shown a screen with a thank you message (Figure 4.40).

*Figure 4.39. Mobile version: The user upload screen.*

*Figure 4.40. Mobile version: the thank you page that is displayed after the upload.*
The live prototype can be viewed by visiting the following link: https://invis.io/DQBQLPT9Y

4.5 Chapter summary

The development process started with prototyping. Developing prototypes is very important, as it demonstrates a proposed interface and helps the gathering of feedback regarding the functionality and design of the website. The first prototype was built in Adobe Photoshop. After revision, a second prototype was designed with Mybalsamiq.

After the prototyping phase, we gathered all the material needed, such as Text descriptions, Images and Videos. The website logo was designed in adobe Photoshop and a customized location map was built with Google Maps.

Additionally, an interactive prototype for a web version of the website was created with Invision.

Finally, all the material was incorporated in the website with the development tool (Wix).
5. Project and Services Evaluation

Evaluation is a very important stage in the project development, as it offers the opportunity to gather feedback in order to add or modify features in the direction of enhancement of quality in the final product. It also shows the degree of success in realizing the requirements that were set at the start of the project. The evaluation of our project was done in two stages.

An evaluation can use qualitative or quantitative data, and it often combines both. Qualitative and quantitative research processes generate different types of data. In qualitative research data consist of textual forms, while quantitative data take the form of numbers. Each of the two research processes employs different methods in order to produce their data. (Garbarino & Holland, 2009).

We used both the quantitative and qualitative method, because the combined data can lead to an improved evaluation, given the fact that the limitations of the one are balanced by other. This diversity in techniques allows researchers to obtain the full array of information on the studied topic (Berger, 2016).

5.1 Qualitative Evaluation

The first stage included a qualitative evaluation among a selected group of users. We gathered a team of four persons, from various areas of expertise, in order to get valuable feedback from different perspectives. The first evaluator is a Social Media executive in the marketing department of a big corporation in Greece. The second evaluator is a journalist and a graduate of the Digital Media, Culture and Communications master's program of Aristotle University of Thessaloniki. The third evaluator is also a graduate of the aforementioned master's program with proven experience in Social Media. The fourth evaluator is a graduate of the Applied Informatics department of University of Macedonia, with experience in Web development.

The group of evaluators was asked to navigate through the SKG parks website. Then, they were asked to fill in a form (Table 3), which is adapted from Chatzara (2015), where they would state any observed problems, the degree of importance of the problem, and the proposed solution to it. To determine the importance of the problem there is a scale from 1 to 5 (1. not important, 2. of low importance 3. Neutral 4. Important 5. Crucial).

The comments that were gathered from the process were in general very positive, while the problems detected were not characterized as crucial.
Table 3: Evaluation form to be filled by experts for the qualitative analysis

<table>
<thead>
<tr>
<th>Evaluation form</th>
<th>Degree of importance</th>
<th>Proposed solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Observed Problem</td>
<td>1 2 3 4 5</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>5</td>
<td></td>
</tr>
</tbody>
</table>

The first evaluator pointed out that, while there are social links on the website, the presence of Social Media elements throughout the website are not very prominent. This was classified as an error of low importance, since it does not disrupt the functioning of the website. It is though, an area in need of improvement, given the fact that Social Media constitute one of the main sources of information for Internet users.

The second evaluator stressed the lack of a secondary language selection. Since the website is addressed to tourists too, it would be particularly useful to have multiple language versions of the website. This was categorized as an important error.

The third evaluator suggested that there should be a further categorization of the information. This could be done by breaking down the information into categories such as historical facts, architectural elements, recreational activities etc. Once again, this was characterized as a low importance error, but it offers a good opportunity for improvement.

Finally, the fourth evaluator pointed out that the website did not have a sitemap in order to facilitate the navigation. But due to the small size and small number of sections of the website, this was characterized as a low importance error.

Overall, all the evaluators agreed that the website has a pleasant and functioning interface, with variety of information and is easy to navigate. While the errors they pointed are not crucial for the smooth functioning of the website, they will serve as a foundation for the further improvement of it.

Figure 5.1 presents a summary of the proposed solutions on problems identified by the evaluators.
The Garden of Alexander

The Garden of Alexander is situated in the area surrounding the iconic statue of Alexander the Great. It is the largest one of the parks. It is created through the unification of three smaller parks, diverse in their organization, with trees, paths, bridges and fountains, which create a vibrant atmosphere. The shaft that leads to the statue has been built in a way that creates a striking background for the sculpture – a real benchmark of the coastal area.

Figure 5.1. Summary of the proposed solutions by the evaluators.
5.2 Quantitative Evaluation

The second stage consists of a quantitative evaluation in order to assess the quality of the produced website.

Website quality assessment is a challenging area and there are various proposed frameworks that evaluate website quality. The interaction between users and websites captures the essence of quality in its various aspects. Literature proposes several criteria for website quality, the main of which are Content, Navigation, Design and structure, Appearance and multimedia and Uniqueness (Moustakis et al, 2004).

5.2.1. Metrics

Hassan & Abuelrub (2010), propose 4 comprehensive criteria that include most dimensions of evaluation methods that exist in literature. These criteria are Content quality, design quality, organization quality and user-friendly quality. Each of these criteria includes a number of indicators, which are illustrated in Table 4.

Table 4: Evaluation criteria and indicators

<table>
<thead>
<tr>
<th>Website Quality</th>
<th>Content</th>
<th>Design</th>
<th>Organization</th>
<th>User-friendly</th>
</tr>
</thead>
<tbody>
<tr>
<td>Timely</td>
<td>Relevant</td>
<td>Multilingual/Culture</td>
<td>Variety of Pres.</td>
<td>Accuracy</td>
</tr>
<tr>
<td></td>
<td>Timely</td>
<td>Relevant</td>
<td>Organization</td>
<td>User-friendly</td>
</tr>
<tr>
<td></td>
<td>Timely</td>
<td>Relevant</td>
<td>Multilingual/Culture</td>
<td>Variety of Pres.</td>
</tr>
<tr>
<td></td>
<td>Timely</td>
<td>Relevant</td>
<td>Multilingual/Culture</td>
<td>Variety of Pres.</td>
</tr>
<tr>
<td></td>
<td>Timely</td>
<td>Relevant</td>
<td>Multilingual/Culture</td>
<td>Variety of Pres.</td>
</tr>
</tbody>
</table>

Electronic questionnaires created with Google Forms were sent to frequent internet users after they had visited the website. We used the above criteria, and adopted a 1 to 5 rating scale for each indicator, where 1 represents “strongly disagree” and 5 represents “strongly agree”. Tables 5,6,7 and 8 include the description of each element that the users were asked to rate.
### Table 5: Content evaluation

<table>
<thead>
<tr>
<th>Content Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Timely</td>
<td>The content is up-to-date and frequently updated.</td>
</tr>
<tr>
<td>Relevant</td>
<td>The content is comprehensive and complete.</td>
</tr>
<tr>
<td>Multilanguage/Culture</td>
<td>The content is available in multiple languages</td>
</tr>
<tr>
<td>Variety of presentation</td>
<td>The content is presented in various forms.</td>
</tr>
<tr>
<td>Accuracy</td>
<td>There are no spelling or grammar errors.</td>
</tr>
<tr>
<td>Objective</td>
<td>Information is objective with no political, cultural or religious bias.</td>
</tr>
<tr>
<td>Authority</td>
<td>Information and contact details of owner and copyright identification are provided.</td>
</tr>
</tbody>
</table>

### Table 6: Design evaluation

<table>
<thead>
<tr>
<th>Design Indicator</th>
<th>Rating</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attractive</td>
<td>Design is innovative, includes graphics and animation, has a positive emotional appeal.</td>
</tr>
<tr>
<td>Appropriateness</td>
<td>Design is appropriate for the subject it carries; there is balance between images and text.</td>
</tr>
<tr>
<td>Color</td>
<td>There is effective color use, light background and no unnecessary use of colors.</td>
</tr>
<tr>
<td>Image/Sound/Video</td>
<td>Amount and size of non-text elements is appropriate.</td>
</tr>
<tr>
<td>Text</td>
<td>Text is consistent; there is no variation of fonts; no capitals are used for text; there are headings such as titles and sub-titles.</td>
</tr>
</tbody>
</table>
Table 7: Organization evaluation

<table>
<thead>
<tr>
<th>Organization Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index</td>
<td>There is a link to every page in the homepage</td>
</tr>
<tr>
<td>Mapping</td>
<td>Navigation menu is available in each page.</td>
</tr>
<tr>
<td>Consistency</td>
<td>The general page layout is consistent throughout the website.</td>
</tr>
<tr>
<td>Links</td>
<td>Links are properly assigned to their destination pages and there are assistant links to facilitate navigation (e.g. to return to the top of the page).</td>
</tr>
<tr>
<td>Logo</td>
<td>Logo is clear and appears in all pages.</td>
</tr>
</tbody>
</table>

Table 8: User-friendly evaluation

<table>
<thead>
<tr>
<th>User-friendly Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Usability</td>
<td>The website is easy to navigate and understand.</td>
</tr>
<tr>
<td>Reliability</td>
<td>Address is subject-appropriate and easy to remember; The website is supported by multiple browsers; It is always available; there is no big amount of ads.</td>
</tr>
<tr>
<td>Interactive features</td>
<td>There are instructions to facilitate use; there is a help section and error messages; There is a FAQ section; there is a search function; there is a communication and feedback channel with the owner.</td>
</tr>
<tr>
<td>Customization</td>
<td>Users can customize the content according to specific preferences.</td>
</tr>
</tbody>
</table>

5.2.3 Results

This section presents the results of the conducted analysis.

Participants are mainly between the age of 30-50 years (50%), while 45% is under 30 years old and the remaining 5% are over the age of 50. About a 50% of the participants owns a master’s degree and 30% of them a bachelor’s degree. The clear majority (90%) use the internet several times a day (Figures 5.2, 5.3 & 5.4).
Figure 5.2. Age results of evaluation questionnaire.

Figure 5.3. Education level results of evaluation questionnaire.
Regarding Content quality, the evaluation showed that participants found the content relevant, it is presented in various forms, is precise and objective. There is room for improvement as far as the support for different languages is concerned, which participants rated lower. Results also showed that information concerning contact details and copyright identification should be reviewed (Figures 5.4, 5.5, 5.6, 5.7, 5.8, 5.9 & 5.10).

Figure 5.4. Content - timely results on evaluation questionnaire.
The content is available in multiple languages.

20 responses

Figure 5.5. Content - timely results on evaluation questionnaire.

The content is comprehensive and complete.

20 responses

Figure 5.5. Content - relevant results on evaluation questionnaire.

The content is available in multiple languages.
NON-LINEAR STORYTELLING ENVIRONMENTS

Figure 5.6. Content – Multilanguage/culture results on evaluation questionnaire.

There are no spelling or grammar errors.

Figure 5.8. Content - accuracy results on evaluation questionnaire.
For the Design quality, the evaluation result was generally positive. Participants found that the design is subject appropriate and has a positive emotional impact, as colors were carefully selected and a minimalistic design was adopted. Background and text colors were used according to the color theory that was studied before implementing the project. Images and videos are of right amount and size. Texts have a consistent style and appropriate size, and there is enough blank space to avoid overcrowded pages. The results showed that there needs to be improvement on design details, such as size of non-text elements and font variation (Figures 5.11, 5.12, 5.13, 5.14 & 5.15).
NON-LINEAR STORYTELLING ENVIRONMENTS

**Design evaluation**

Design is innovative, includes graphics and animation, has a positive emotional appeal.

20 responses

![Bar chart showing attractiveness results on evaluation questionnaire.](chart.jpg)

**Figure 5.11.** Design – attractive results on evaluation questionnaire.

Design is appropriate for the subject it carries; there is balance between images and text.

20 responses

![Bar chart showing appropriateness results on evaluation questionnaire.](chart.jpg)

**Figure 5.12.** Design – appropriateness results on evaluation questionnaire.
There is effective color use, light background and no unnecessary use of colors.
20 responses

Figure 5.13. Design – color results on evaluation questionnaire.

Amount and size of non-text elements is appropriate.
20 responses

Figure 5.14. Design – image/sound/video results on evaluation questionnaire.
For the Organization quality, the evaluation result was also positive. Links are properly assigned and the logo is clear and present in all pages. Participants’ ratings showed that there needs to be reviewing in order to provide navigation to all the pages from the homepage (Figures 5.16, 5.17, 5.18, 5.19 & 5.20).

Figure 5.15. Design – text results on evaluation questionnaire.

Figure 5.16. Organization – index results on evaluation questionnaire.
Figure 5.17. Organization – mapping results on evaluation questionnaire.

Figure 5.18. Organization – consistency results on evaluation questionnaire.
For the User-friendly quality, the evaluation showed some negative results. While the website provides easy navigation, and is reliable, there needs to be improvement concerning the creation of a help page and a search function. Customization is also a feature that the website lacks, but this is due to the limitations of the building platform (Figures 5.21, 5.22, 5.23).
User-friendly evaluation

Address is subject-appropriate and easy to remember; The website is supported by multiple browsers; It is always available; there is no big amount of ads.

20 responses

Figure 5.21. User friendly – reliability results on evaluation questionnaire.

There are instructions to facilitate use; there is a help section and error messages; There is a FAQ section; there is a search function; there is a communication and feedback channel with the owner.

20 responses

Figure 5.22. User friendly – interactive features results on evaluation questionnaire.
Overall, the website fulfills most of the quality requirements. It provides the user with an attractive design, accurate content and variety of multimedia. The major areas that are in need of improvement are the frequency of updates, the multiple language support, the customization feature and the help provision.

In any case, further evaluation from a larger sample of representative users of the target audience needs to be done, in order to provide us with useful conclusions.

5.3 Mobile app assessment: evaluating interactive prototypes

In order to evaluate the interactive prototype of the mobile version of SKG parks, we used Invision’s collaborative tool (Liveshare) that was described in chapter 4.4.2. We shared the prototype with three of the individuals that took part in the desktop version evaluation.

There was an overall positive evaluation of the prototype and the evaluators agreed that it is easy to navigate and incorporates all the important sections of the desktop website. They also pointed out comments about areas that need altering or improvement. In particular:

Evaluator 1 pointed out that the social links on the top left hand side corner and the logo need to be sized down as they occupy space on the header, which should be smaller. They also mentioned the absence of “back” buttons in some of the pages.

Evaluator 2 proposed the addition of “back to top” buttons in pages that contain big volume of content, as users have to scroll down a lot, in order to make the navigation easier. They also pointed out that the names of the parks in the “Parks” page need to...
be displayed in a different manner, as they do not appear complete and it creates frustration.

Evaluator 3 pointed out that the interface of the UGC content needs to be improved, mainly in the comments section, so as to be able to contain more volume of content and arrange it in a manner that is easier to view.

Figure 5.24 presents a summary of the comments received by the evaluators.
Figure 5.24. Summary of comments on mobile prototype by evaluators.
6. Project Summary

6.1 Summary & Conclusions

The purpose of this dissertation is to illustrate the method that a non-developer can adopt in order to create a website that contains a non-linear storytelling environment. Before embarking on the actual development, we studied the theory behind storytelling and its advancement combined with the rise of multimedia and the Web. Next, we studied the models that exist in the area of Software and Web development in order to adopt the philosophy that governs this process and have a successful planning for the project. Another important part of the pre-development stage was to study the basic theories about design, in order to be able to create a successful user interface. These theory topics provided us with the foundation for a successful outcome that can compete with a result that a professional would have.

After the study of the theory, extensive research about the selected topic took place. We researched the history of the creation of the Parks and interviewed the architects in order to get better insight. We also searched the Web for relevant websites in order to identify the best practices and get inspiration. The research of the topic background enabled us to obtain thorough knowledge on the subject in order to present it in the best way possible.

The actual implementation of the project took place in 4 stages: Firstly, we outlined the thematic categories according to the requirements we had set and arranged them into a navigation plan. Secondly, we proceeded to design prototypes for the website, based on which we collected feedback and made alterations. Thirdly, we gathered all the material needed for the website, including text, images and video material. Finally, we developed the website on the selected platform after we had thoroughly understood its tools and functions. Additionally, we created an interactive high fidelity prototype for a mobile version of the website.

After the development of the core website as per the basic requirements, we proceeded to the evaluation of it. We used a qualitative as well as a quantitative method. Results showed that the result website fulfills most of the quality requirements. Additionally, evaluation of the interactive prototype for the web version was performed.

As mentioned before, the purpose of this project was to show the way a non-developer can create a successful website without the need of coding skills and special software. Web building platforms offer the opportunity to simple users to develop professionally-looking websites. When combined with the correct foundation of theory study and topic research, the produced result can compete with professionally made websites, both in appearance as well as in quality, as the evaluation showed.
6.2 Thesis novelty and contribution

As part of the analysis, design and development of the SKG parks, several tools were tested. After exploring and reviewing different platforms, from the prototyping stage to the actual development of the website, we selected the ones that we believe sum up the best qualities for the desired outcome. The asked qualities were ease of use, as this work is targeted to users that lack coding skills, multiple tools and functions and functional and aesthetically pleasing results. The combination of selected tools that are presented in this thesis, used in harmony with the guidelines that the theory proposes, constitutes a good practices guide for non-developers.

The process followed can be used as a tutoring resource in courses related to Web building for non-developers as well as a supplement to a related learning curriculum. Additionally, the produced website (SKG parks), can be used as a foundation that can be further enhanced and developed and serve as a medium of promotion for the area.

6.3 Further Work

While at this stage the project is considered complete as far as the starting requirements are concerned, no web project is ever truly complete. The Web is a constantly changing medium and therefore affects web applications, in a way that they always need further modification and addition of new features.

As far as the desktop version is concerned, the feedback received from the evaluation process needs to be addressed. There needs to be improvement to facilitate navigation, such as the addition of search function and a sitemap, and also the provision of a second language. Social network presence must be more prominent. The homepage must be reviewed in order to incorporate links to all the sections of the website. Customization features can be added in order to improve the use of experience, but the nature of the platform used does not allow this to be implemented.

Additionally, further evaluation needs to be done in order to get clearer results. The questionnaire of the quantitative part of the evaluation can be disseminated to groups of visitors of the page through the website itself or the project’s social media accounts to gather a larger sample that can deliver more concrete results.

Finally, as far as the interactive prototype for the web version is concerned, the actual development of the prototype work has to be done. The limitations of the used development platform (Wix) do not allow for this process to be done by non-developers, so this part can only be realized by professionals in the field. As this is a prototype, it contains a very basic representation of the User Generated Content platform. The actual implementation of the platform would require the addition of features to take advantage of mobile technologies such as location awareness, and also the use of a moderation system in order to filter the user uploaded content.
6. References


Non-linear storytelling environments


